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Copyright © ViewSonic Corporation, 2002. All rights reserved. 

ViewSonic and the three birds logo are registered trademarks of 
ViewSonic Corporation.

Microsoft, Windows, the Microsoft Internet Explorer logo graphic, ActiveSync, 
PowerPoint, Outlook, DirectX, DirectSound, Pocket Word, MSN, Pocket Excel, 
Pocket Internet Explorer, Microsoft Exchange, and the Windows logo are either 
registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries. ClearVue is a trademark of the Westtek 
Corporation.

Corporate names and trademarks are the property of their respective 
companies.

Disclaimer: ViewSonic Corporation shall not be liable for technical or editorial 
errors or omissions contained herein; nor for incidental or consequential 
damages resulting from furnishing this material, or the performance or use of 
this product.

In the interest of continuing product improvement, ViewSonic Corporation 
reserves the right to change product specifications without notice. Information 
in this document may change without notice.

No part of this document may be copied, reproduced, or transmitted by any 
means, for any purpose without prior written permission from ViewSonic 
Corporation. 

Product Registration
To meet your future needs, and to receive any additional product information as 
it becomes available, please register your product on the Internet at: 
www.viewsonic.com. The ViewSonic® Wizard CD-ROM also provides an 
opportunity for you to print the registration form, which you may mail or fax to 
ViewSonic.

For Your Records

Product Name:
Model Number:
Document Number:
Serial Number:
Purchase Date:

ViewSonic Pocket PC V35 
VSMW25410-1
A-CD-PPCV35-UG  Rev. 1A
__________________
__________________
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 1  Getting Started
Congratulations on your purchase of the ViewSonic Pocket PC V35. The V35 is a 
Windows® Powered Pocket PC that enables you to keep your most important 
business and personal information up-to-date and close at hand. Microsoft 
ActiveSync increases the power of your device by allowing you to synchronize 
information on your desktop or laptop computer with your V35. 

This chapter introduces you to the internal and external components of the 
ViewSonic Pocket PC V35.

Package Contents
When you unpack the contents of the Pocket PC V35, verify that you have all of 
the items listed below.

• ViewSonic Pocket PC V35

• Stylus

• AC adapter

• USB cradle

• SD dummy card (inside the slot)

• Carrying case

• ViewSonic Pocket PC V35 Companion CD (contains Microsoft ActiveSync®, 
Microsoft Outlook 2000, ClearVue Image, ClearVue Presentation, and the 
V35 User Guide in PDF format)

• User Guide

Accessories
You can expand your V35’s capabilities or replace lost parts by purchasing 
accessories. Go to www.viewsonic.com for information about V35 
accessories.
ViewSonic  Pocket PC   V35 1   
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QUICK START
Using the V35 for the first time

1  Identifying Components

Power Button

Stylus

SD Card Slot

Infrared (IR) Port

Touch Screen

Scroll Dial

Record Button

Reset Switch

Power Connector 
(connect to AC adapter)

USB Cradle Connector

Program Buttons (4)

Microphone

Notification Indicator (Red)

Battery-Charging Indicator 
(Amber)

Headphone 
Connector

Speaker

Navigation Pad

Lanyard Eyelet
2        ViewSonic   Pocket PC   V35
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2  Setting the Battery Switch
The switch on the back of your Pocket PC V35 should be switched to the ON 
(down) position. If this is not the case, please set it to ON.

1 Make sure that theV35 is turned off. 

2 Unscrew the rear cap of your stylus. Use the pointed end of the cap to slide 
the battery switch to the ON (down) position.

3 The Notification indicator will flash red for approximately 30 seconds, and 
then your V35 will automatically turn on and display the Welcome Wizard 
screen. 

IMPORTANT: Keep the battery switch set to ON (down position) unless 
you need to restore factory defaults.

3  Charging the Battery
Connect your V35 to an AC power source.

 Plug the V35 into the USB cradle. 

NOTE: You can also connect the V35 directly to the AC adapter without using 
the USB cradle. For more information see “Battery Charging Options” in this 
chapter.

 Plug the appropriate end of the AC adapter into the power connector on the 
USB cable.

NOTE: For information about battery replacement, see page 80.

1

2
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 Plug the other end of the AC adapter into a grounded AC outlet.

The battery-charging indicator lights amber when charging is in progress.

4 Fully charging may require a couple of hours. The amber battery-charging 
indicator turns off when the battery is fully charged.

NOTE: Whenever possible, charge the battery by connecting the V35 to an AC 
power source. This will keep the battery charged and prevent data loss or 
damage to the battery in case the battery has been kept in a discharged state 
for too long.

4  Starting Your V35
Press the power button to turn the V35 on.

The first time you start your V35, the Welcome Wizard screen appears. The 
wizard's on-screen instructions will lead you through the setup process. Follow 
the instructions to complete the process and begin using your V35.

5  Installing Microsoft ActiveSync
A key component of your V35 is the Microsoft ActiveSync® program. With 
Microsoft ActiveSync, you can synchronize the information on your PC with 
information on your V35 and update both with the most recent information.

ActiveSync is already installed on your V35. You need to install ActiveSync on 
your PC. Follow the procedure below:

3
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IMPORTANT:
• Before installation, make sure you have Microsoft Outlook installed 

on your PC. If you do not have Outlook, you can install Outlook 2000 
from the provided ViewSonic Pocket PC V35 Companion CD.

• Do not connect your V35 to your PC before ActiveSync is installed.

1 Turn on your PC.

2 Insert the Microsoft ActiveSync Utility CD into the CD-ROM drive of your PC.
The ActiveSync installation screen should open immediately. If this does not 
happen, double-click Setup.exe and go to Step 3.

3 Click the arrow on the first screen to enter the main screen. Click Start 
Here, then click Install ActiveSync 3.5. Click Install to start the 
installation. 

6  Connecting to Your PC
1 When prompted, connect your V35 to your PC using the USB cradle as 

follows:  

(1) Place the V35 in the USB cradle.

(2) Connect the AC adapter to the power connector on the USB plug. 

(3) Connect the USB cable to your PC.

2 Follow the on-screen instructions to synchronize the V35 with your PC. 

After your first synchronization, the data you have stored on your PC, such as 
Calendar, Contacts, and Tasks, is copied to your V35. You’re now ready to take 
it along with you when you go.

For more information on ActiveSync, see Chapter 4.
ViewSonic  Pocket PC  V35 5   
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Register Your Product
Go to www.ViewSonic.com to register your V35. You will need to know the 
serial number of your V35 (see the back of the V35). To help with identification 
in the event of theft or loss, keep this User Guide as a permanent record of your 
purchase. 

For More Information

For information on: See this source

Complete information for operating the 
V35

V35 User Guide (In addition to the paper version, the User 
Guide is also available as a PDF file on the ViewSonic Pocket 
PC V35 Companion CD.)

Programs on your Pocket PC V35 User Guide or ActiveSync Help on your PC.

Additional programs that can be 
installed on your Pocket PC

ViewSonic Pocket PC V35 Companion CD

Connecting to and synchronizing with 
a PC

V35 User Guide or online Help. Tap Help on the Start menu to 
view Help.

ViewSonic Customer Support Chapter 10 of the V35 User Guide

Troubleshooting V35 User Guide

Last-minute updates and technical 
information

The Read Me files in the “Microsoft ActiveSync” folder on your 
PC or the ViewSonic Pocket PC V35 Companion CD

The latest on Windows Powered 
Pocket PCs

The Microsoft Mobile Devices Web site:
www.microsoft.com/mobile/pocketpc
6        ViewSonic   Pocket PC   V35
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Hardware Features
The illustrations below introduce you to the various buttons, connectors, ports, 
and other features of your V35.

Front Components

 Ref Component Description

Touch Screen Selects menu commands or input text.

Program Buttons Provides a quick way to run a specific program. By default, 
they are Notes, Calendar, Contact, and Tasks buttons (left 
to right).

Microphone Receives sound and voice to record voice notes. 

Directional Pad Move up, down, left, or right in a document.

 
Speaker Sends out music or audible reminders and alerts.

Battery Charge 
Indicator

Glows amber when battery is being charged and turns Off 
when battery is fully charged.

Notification 
Indicator

Informs you about scheduled appointments, alarms, 
reminders, and voice recording status.

2

3

4

5

6

7

1

1

2

3

4

5

6

7
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Rear Components

Ref Component Description

Battery Switch Restores your V35 to the factory default settings and clears 
all data stored in RAM.

NOTE: Always leave the switch in the ON (down) position 
unless you need to perform a hard reset.

1
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Right-Side Components

Ref Component Description

Stereo Headphone 
Connector

Connects stereo headphones.1
ViewSonic  Pocket PC  V35 9   
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Left-Side Components

Ref Component Description

Lanyard Eyelet Lanyard attaches to this opening.

Scroll Dial Selects the highlighted item, or scrolls up or down in a 
document.

Record Button Record voice notes by pressing and holding this button.

Reset Switch Restarts your V35.

1

2

3

4
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Top Components

Bottom Components

Ref Component Description

IR Port Beams files to or from other mobile devices using infrared 
(IR).

SD Card Accepts an optional Secure Digital card for extended 
memory capacity or extended capabilities.

Power Button Turns your V35 On or Off, or turns the backlight On or Off by 
pressing and holding this button.

Stylus Slot Store the stylus in the stylus slot when not in use.

Ref Component Description

Cradle Connector Connects the V35 to the USB cradle to charge the battery 
and to synchronize the V35 with your PC.

Power Connector Connects the V35 to the AC adapter when not using the 
USB cradle.

1

2

3

4

1

2
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V35 USB Cradle
The USB cradle provides a convenient way to charge your V35 and connect your 
V35 to a PC through a USB connection.

Ref Component Description

 
USB Connector Connects to your PC for data synchronization.

Power Connector Connects to the DC plug of the AC adapter.

 
Pocket PC 
Connector

Connects to your Pocket PC V35.

 
AC adapter Connects to an AC outlet.

1

2

3

4
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Battery Charging Options
With the cradle
1 Slide your V35 into the cradle.

2 Plug the appropriate end of the AC adapter into the power connector on 
the USB.

3 Plug the other end of the AC adapter into an AC outlet.

Without the cradle
Connect the DC plug from the AC adapter to the power connector on the 
bottom of the V35, and plug the AC adapter into an AC outlet. 

The battery-charger indicator lights amber when charging is taking place.
ViewSonic  Pocket PC  V35 13   

Download from Www.Somanuals.com. All Manuals Search And Download.



V35_UG.book  Page 14  Monday, October 28, 2002  4:56 PM
• Allow the battery to become fully charged (about two hours). 
The amber Battery Charge Indicator turns off when the battery is fully 
charged. 

Whenever possible, charge the battery by connecting your V35 to an AC power 
source. This will keep the battery charged and prevent data loss or damage to 
the battery in case the battery has been kept in a discharged state for too long. 

Expanding the Memory Capacity
Using an SD Card (Optional)
Your V35 has an SD card slot which accepts an SD (Secure Digital) memory 
card. You can purchase an SD card to expand the memory capacity and 
capabilities of your V35.

To insert an SD card:

1 Slide the end of the card with the chipped corner into the SD slot (with the 
label side and the V35’s front panel facing you).

2 Push the card into the slot until it clicks into place. 

To remove an SD card:

• Press the card. When the card pops out slightly, you can remove it.
14        ViewSonic   Pocket PC   V35
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 2  Basic Skills
This chapter introduces you to the basics of working with programs and 
documents on your V35.

Using the Stylus
Use the stylus to navigate and select objects on the V35 touch-screen.

NOTE: You can extend the stylus to hold it more comfortably.

• Tap: Touch the screen once with the stylus to open items and select options.

• Drag: Hold the stylus on the screen and drag across the screen to select 
text and images. Drag in a list to select multiple items.

• Press and hold: Press and hold the stylus on an item to see a list of actions 
available for that item. On the pop-up menu that appears, tap the action you 
want to perform.
ViewSonic  Pocket PC   V35 15   
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Today Screen
When you turn on your V35 for the first time each day (or after 4 hours of 
inactivity), you will see the Today screen. On the Today screen, you can see at a 
glance important information for the day.

You can also display the Today screen by tapping and then tapping Today. 

Tap to switch 
to a program.

Tap to change Volume or Mute all sounds.

Tap to change date and time.

Tap to open an item.

Your day at a glance

Tap to create a new item.  Tap to view connection status.

Navigation Bar

Command Bar
16        ViewSonic   Pocket PC   V35
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Status Icons
When the Today screen is displayed, you may see the following status icons on 
the Command bar or Navigation bar. In most cases, you can tap a status icon to 
display the associated control panel or more information related to the item.

For example, tap to see information about the battery charging status.

 

Icon Meaning

Speaker is On

Speaker is Off

Main battery is charging

Main battery is low

Main battery is very low

Main battery is fully charged

Connection is active

Synchronization is beginning or ending

Synchronization is occurring 
ViewSonic  Pocket PC  V35 17   
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Navigation Bar and Command Bar
The Navigation bar is located at the top of the screen. It displays the active 
program and current time, and allows you to switch programs and close 
screens.

The Navigation bar and Start menu:

Use the Command bar at the bottom of the screen to perform tasks in 
programs. The Command bar includes menu names, buttons, and the Input 
panel button. To create a new item in the current program, tap New. To see the 
name of a button, press and hold the stylus on the button. Drag the stylus off 
the button so that the command is not carried out.

The Command bar:

Tap to change Volume or Mute all sounds.

Tap to quickly select a program 
you have recently used.

Tap to select a program.

Tap to see additional adjustments.

Tap to customize the device.

New button

Buttons
Menu names

Input panel button
18        ViewSonic   Pocket PC   V35
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Running Programs
Depending on the program you want to run, you can:

• Tap or tap Start at the top of the screen and select from the menu. (You 
can customize which programs you see on this menu. For information, see 
section “Customizing Your V35” in Chapter 3).

• Tap and then tap Programs to access additional programs. Tap the icon 
to run the program.

• Press program buttons on the front of your V35 to open the program. The 
icons on the buttons identify the programs they are associated with. (You 
can customize which programs are associated with the buttons. For 
information, see the section “Customizing Your V35” in Chapter 3).

The following table contains a partial list of the program icons on your V35.

Icon Program Description

ActiveSync Synchronize information between your V35 and PC.

 
Calendar Keep track of your appointments and create 

meeting requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive email messages.

Pocket Internet 
Explorer

Browse Web and WAP (Wide Area Protocol) sites, 
and download new programs and files from the 
Internet.

Notes Create handwritten or typed notes, drawings, and 
recordings.

Tasks Keep track of your tasks.

Pocket Excel Create new workbooks or view and edit Excel 
workbooks created on your PC.

Pocket Word Create new documents or view and edit Word 
documents created on your PC.
ViewSonic  Pocket PC  V35 19   
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Pop-up Menus
With pop-up menus, you can quickly choose an action for an item. For example, 
you can use the pop-up menu in the contact list to quickly delete a contact, 
make a copy of a contact, or send an email message to a contact. The actions 
in the pop-up menus vary from program to program. To access a pop-up menu, 
press and hold the stylus on the name of the item that you want to perform the 
action on.

When the menu appears, lift the stylus, then tap the action you want to 
perform. Or tap anywhere outside the menu to close the menu without 
performing an action.

Notifications
Your V35 reminds you in a variety of ways when you have something to do. For 
example, if you have set up an appointment in Calendar, a task with a due date 
in Tasks, or an alarm in Clock, you will be notified in any of the following ways:

• A message appears on the screen.

• A sound, which you can specify, is played.

• The notification LED flashes.

To choose reminder types and sounds for your V35, tap Settings on the Start 
menu. On the Personal tab, tap Sounds & Notifications.

Press and hold to display the pop-up menu.

Using the tip of the sylus, tap the 
action you want.

Tap outside the menu to close it (when you 
decide not select an option on the menu).
20        ViewSonic   Pocket PC   V35
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Entering Information
You have several options for entering new information:

• Use the Input panel to enter typed text, either by using the soft (on-screen) 
keyboard or other input methods.

• Write directly on the screen.

• Draw pictures on the screen.

• Speak into the microphone to record a message. For more information on 
using the microphone, see the section on “Recording a Message”.

Entering Text Using the Input Panel
Use the Input panel to enter information in any program on your V35.

You can either type using the soft (on-screen) keyboard or write using the Block 
Recognizer or Letter Recognizer. In any case, the characters appear as typed 
text on the screen.

To show or hide the Input panel, tap the Input panel button. Tap the arrow 
next to the Input panel button to see your choices.

When you use the Input panel, your V35 anticipates the word you are typing or 
writing and displays it above the Input panel. When you tap the displayed word, 

Select an input method.

Input Panel button

Tap to see your choices.
ViewSonic  Pocket PC  V35 21   
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it is inserted into your text at the insertion point. The more you use your V35, 
the more words it learns to anticipate.

NOTE: To change word suggestion options, such as the number of words 
suggested at one time, tap Setting on the Start menu. On the Personal tab, 
tap Input, then tap the Word Completion tab.

Block Recognizer
With Block Recognizer, you can use the stylus to input characters and words.

To type with Block Recognizer:

1 Tap the arrow next to the Input panel button, and then tap Block 
Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the 
screen. For specific instructions on using Block Recognizer, open Block 
Recognizer, and then tap the question mark (?) next to the writing area.

Soft Keyboard
The Soft Keyboard is an on-screen keyboard displayed at the bottom of the 
screen.

To type with the soft keyboard:

1 Tap the arrow next to the Input panel button, and then tap Keyboard.

2 On the keyboard that is displayed, tap the keys with your stylus.

Tap here if this is the right word.
22        ViewSonic   Pocket PC   V35
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Letter Recognizer
With Letter Recognizer, you can write letters using the stylus just as you would 
use a pen on paper.

To type with Letter Recognizer:

1 Tap the arrow next to the Input panel button, and then tap Letter 
Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the 
screen. For specific instructions on using Letter Recognizer, open Letter 
Recognizer and then tap the question mark next to the writing area.

Transcriber
With Transcriber you can write anywhere on the screen using the stylus just as 
you would on paper. Unlike Letter Recognizer and Block Recognizer, you can 
write a sentence or more of information; then, you pause and let Transcriber 
change the written characters to typed characters. 

To type with Transcriber:

1 Tap the arrow next to the Input panel button, and then tap Transcriber.

2 Write anywhere on the screen.

For specific instructions on using Transcriber, open Transcriber and then tap the 
question mark in the lower-right corner of the screen.
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Writing on the Screen
In any program that accepts writing—such as the Notes program and the 
Notes tab in Calendar, Contacts, and Tasks—you can use your stylus to write 
directly on the screen. Write the way you do on paper. You can edit and format 
what you have written and convert the information to text later.

To write on the screen, tap the Pen button to switch from tapping to writing 
mode. This action displays lines on the screen to help you write.

Some programs that accept writing may not have the Pen button. See the 
documentation for that program to find out how to switch to writing mode.

If you want to edit or format writing, you must select it first.

To select writing:

1 Press and hold the stylus next to the text you want to select until the 
insertion point appears.

2 Without lifting, drag the stylus across the text you want to select.

If you write accidentally on the screen, tap Tools, then Undo, and try again. 
You can also select text by tapping the Pen button to deselect it and then 
dragging the stylus across the screen.

Tap the Pen button and use 
your stylus like a pen.
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You can cut, copy, and paste written text in the same way you work with typed 
text: press and hold the stylus on the selected words and then tap an editing 
command on the pop-up menu, or tap the command on the Edit menu.

To convert writing to text, tap Recognize on the Tools menu.

If you want to convert only certain words, select them before tapping 
Recognize on the Tools menu (or press and hold the selected words and then 
tap Recognize on the pop-up menu). If a word is not recognized, it is left as 
writing.

Select the text you want to 
convert and tap Recognize 
on the Pop-up menu.

Your handwriting is 
turned into text.
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If the conversion is incorrect, you can select different words from a list of 
alternates or return to the original writing. To do so, press and hold the 
incorrect word (tap one word at a time). On the pop-up menu, tap Alternates.

A menu with a list of alternate words appears. Tap the word you want to use, or 
tap the writing at the top of the menu to return to the original writing.

Some tips for getting good recognition are listed below:

• Write on the lines and draw descenders below the line. Write the cross of the 
“t” and apostrophes below the top line so that they are not confused with 
the word above. Write periods and commas above the line.

For better recognition, use the Tools menu to increase the zoom level to 300%.

• Write the letters of a word close together and leave big gaps between words.

• Hyphenated words, foreign words that use special characters such as 
accents, and some punctuation cannot be converted.

• If you add writing to a word to change it (such as changing a “3” to an “8”) 
after you attempt to recognize the word, the writing you add will not be 
included if you attempt to recognize the writing again.

Or, tap outside the 
pop-up window to return 
to your original writing.

Tap the word you want 
to use.
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Drawing on the Screen
You can draw on the screen in the same way that you write on the screen. The 
difference between writing and drawing on the screen is how you select items 
and how they can be edited. For example, selected drawings can be resized, 
while writing cannot.

To create a drawing, cross three ruled lines on your first stroke. A drawing box 
appears. Drawings that do not cross three ruled lines will be treated as writing.

You may want to change the zoom level so that you can more easily work on or 
view your drawing. Tap Tools, then choose a zoom level.

If you want to edit or format a drawing, you must select it first.

To select a drawing, press and hold the stylus on the drawing until the selection 
handle appears. To select multiple drawings, deselect the Pen button and then 
drag to select the drawings you want.

You can cut, copy, and paste selected drawings by pressing and holding the 
selected drawing and then tapping an editing command on the pop-up menu, or 
by tapping the command on the Edit menu. To resize a drawing, make sure the 
Pen button is not selected, and then drag a selection handle.

The drawing box indicates the 
boundaries of the drawing.
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Recording a Message
In any program where you can write or draw on the screen, you can also 
quickly capture thoughts, reminders, and phone numbers by recording a 
message. In Calendar, Tasks, and Contacts, you can include a recording in the 
Notes tab. In the Notes program, you can either create a stand-alone 
recording or include a recording in a written note. If you want to include the 
recording in a note, open the note first. In the Inbox program, you can add a 
recording to an email message.

To create a recording:

1 Hold the V35’s microphone about three inches from your mouth.

2 Press and hold the record button on the left side of the unit. If the speaker is 
not muted, a beep indicates that your V35 is recording. The notification LED 
at the top of the unit glows red while recording is in progress.

3 While holding down the record button, speak into the microphone.

4 To stop recording, release the record button. Two beeps will sound. The new 
recording appears in the note list or as an embedded icon.

NOTE: You can also make a recording by tapping the Record button on the 
Recording toolbar. 

To play a recording:

• Tap it in the list or tap its icon in the note.

Indicates an embedded 
recording.

Tap to begin recording.

Tap to show or hide the 
Recording toolbar.
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Recording Formats
Your V35 supports several formats for voice notes. The formats vary in both the 
quality of the recording and the size of the sound file. When selecting a 
recording format, you should consider the quality you need as well as how 
much storage memory the recording will use on your V35.

Not all recording formats are compatible with other software or computers. If 
you will share your recordings with others or transfer a recording to your PC, be 
sure to choose a recording format that is supported by the software used to 
play recordings on the other computer.

To select a recording format:

1 On the Start menu, tap Settings, and then tap the Input icon.

2 On the Options tab in the Input control panel, select a voice recording 
format from the drop-down list.

The list of recording formats on your V35 indicates the sample rate, whether 
the format is stereo or mono, and how much storage memory is required per 
second of recording. You may need to experiment with different sample rates 
and formats to determine which format best suits your voice.

Using My Text
When using Inbox, use My Text to quickly insert preset or frequently used 
messages into the text entry area. To insert a message, tap My Text, and then 
tap a message.

NOTE: After inserting a My Text message, you can add text to it before you 
send the message.

To edit a My Text message, on the Tools menu, tap Edit My Text Messages. 
Select the message you wish to edit and make desired changes.
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 3  Managing Your V35
This chapter tells you how to effectively manage power and memory, and how 
to add/remove programs and back up your data.

Managing Power
It is important to maintain a continuous power supply to the V35 to prevent 
data or files stored in RAM from being damaged. Your V35 can operate either on 
external AC power or internal battery power. Note that you will lose any 
information, programs or settings that you have added if the battery completely 
runs out of power.

A fully charged battery should provide power for up to 8 hours of use. The 
operating time of a fully charged battery depends on how you are using the 
V35. Using some functions, such as some of the multimedia features or a 
Secure Digital card, may consume extra battery power.

You should recharge the battery when a warning of low power is displayed on 
your V35, or the V35 will turn off automatically. You will need to connect the 
V35 to external AC power for charging before you can use it again.

See Chapter 1 for information about powering on your V35.

To check the remaining power:

1 On the Start menu, tap Settings.

2 On the System tab, tap the Power icon.

The remaining power is displayed on a status bar in the Power control panel.

Power-Saving Tips
Follow these suggestions to maximize the battery’s operating time:

• Turn off the backlight. Press and hold the power button to turn off the 
backlight, or use the Backlight control panel to set the backlight to turn off 
automatically after a short period of inactivity.
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• Suspend frequently. Use the Power control panel to shorten the length of 
continuous idle time before your V35 auto-suspends. Press the power button 
to turn off your V35 when it is not in use, even for a short time.

• Always use AC power when connecting your V35 to your PC. Note 
that your V35 will not auto-suspend while it is connected.

• Turn off sounds. Use the Sounds & Notifications control panel to turn off all 
but the most necessary system sounds.

• Avoid using memory card accessories while on battery power. Some 
memory cards use considerable power and will quickly drain your battery.

• Do not “listen” for infrared transfers. Although you can set your Pocket 
PC to constantly monitor the IR port for files sent from other devices, doing 
so will quickly drain your batteries.

Managing Memory
Your V35 uses two kinds of memory: storage and program memory (RAM), and 
optional memory cards.

Storage and Program Memory
RAM (Random Access Memory) on your V35 is shared between storage memory 
and program memory. “Storage memory” is used to store the data you create 
and additional programs you install. “Program memory” is used to run 
programs on your V35. Your V35 automatically manages the allocation between 
storage and program memory. However, in some situations, such as when the 
memory is running out, your V35 may not be able to automatically adjust the 
allocation.

Memory Cards 
Memory cards are small, removable flash storage cards that enable you to 
expand the memory of your V35. You can use memory cards for backup 
storage, archives, or to transfer large files to other devices. Your V35 supports 
Secure Digital memory cards. Memory cards can be purchased from a variety of  
third-party vendors.

SDRAM Memory Allocation 
Please see “SDRAM Memory Allocation” in the Appendix on page 84.
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Finding and Organizing Information
The Find feature on your V35 helps you quickly locate information.

To find a file, on the Start menu, tap Find. Enter the text you want to find, 
select a data type, and then tap Go to start the search.

NOTE: To quickly find information that is taking up storage space on your V35, 
select Larger than 64KB under Type. 

You can also use the File Explorer to find files on your V35 and to organize 
these files into folders. On the Start menu, tap Programs, and then tap File 
Explorer.

Select the sort order for the list.

Press and hold to create a new folder.

Tap the folder name to open it.

Tap to change folders.
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Customizing Your V35
You can customize the settings of the V35 to your own preferences.

Tap Start, then tap Memory cards Settings. You can tap any of the icons on 
the Personal, System, or Connections tabs to customize your V35. The 
customization options are as follows:

Options Description

PERSONAL Buttons Assigns your favorite programs to the program buttons, 
and sets the repeat rate of the scroll dial.

Input Sets the settings related to Block Recognizer, soft 
keyboard, Letter Recognizer and Transcriber input 
methods.

Menus Selects the items that appear on the Start menu and the 
New menu on the Today screen.

Owner 
Information

Save your personal information.

Password Sets the password to your V35 to protect the stored 
data.

Sounds & 
Notifications

Sets the conditions and types of the sounds, system 
volume, and ways of notifications.

Today Sets the items that appear on the Today screen.

SYSTEM About Shows information about the version of the operating 
system, the name of the Pocket PC, and copyrights.

Backlight Adjust the backlight of the display.

Clock Sets the current time and alarm.

Memory Adjusts the allocation of data and program storage.

Power Show the remaining battery and external AC power, and 
set the time for the V35 to turn off automatically.

Regional 
Settings

Sets the region of your location, and formats for number, 
currency, time and date.

Remove 
Programs

Removes programs pre-installed in RAM.

Screen Realigns the touch screen for accurate taps.
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Setting a Password
A password can safeguard your V35 against unauthorized use. To set your 
password:

1 Tap Start, tap Settings, then tap the Password icon on the Password tab.

2 Tap the digits or characters to set your password. You can set a four-digit 
password, or a long password containing a combination of at least seven 
characters, digits or punctuation.

3 You can set the time for the V35 to prompt for a password after idling.

4 Tap OK.

Adding or Removing Programs
Adding Programs
You can add even more functionality to your V35 by installing additional 
software and programs. A wide variety of software is available for Windows 
Powered Pocket PCs, ranging from custom business applications and system 
utilities to games and entertainment. Some programs are available from 
software vendors or on the Web.

Install only programs designed specifically to run on a Pocket PC personal 
digital assistant and/or a Windows Powered Pocket PC. You cannot run 
programs designed for Windows on your V35. In addition, you may need a 
version of the program designed specifically for the X-Scale processor used by 
your V35.

Install software to your V35 by first loading the installation files onto your PC. 
Use ActiveSync on your PC to transfer and install programs to the storage 
memory (RAM) in your V35.

Removing Programs
To free storage memory on your V35, you can remove programs you no longer 
use. Only programs that are stored in RAM can be removed. 

Programs pre-installed in Flash ROM cannot be removed; however, these 
programs do not use storage memory.

To remove a program:

1 On the Start menu, tap Settings.

2 On the System tab, tap Remove Programs.

3 Select the program in the list, and then tap Remove.

NOTE: If the program does not appear in the list of installed programs, use 
File Explorer on your V35. Locate the program, press and hold the stylus on 
the program, and then tap Delete on the pop-up menu.
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Backing Up Data
To prevent loss of data, you should back up your V35 frequently. Your V35 
comes with two programs for backing up data:

• Microsoft ActiveSync. ActiveSync enables you to back up data to your PC. 
You can back up all data on your V35, or only your PIM databases (Calendar, 
Contacts, and Tasks). You can set ActiveSync to back up automatically each 
time you connect, or you can back up manually, whenever you choose. For 
more information, see ActiveSync Help on your PC.

• Backup. Backup enables you to back up all data stored in the internal 
(RAM) memory on your V35. You can save the backup file on an optional 
Secure Digital memory card.

Using Backup
Backup gives you added flexibility in backing up your valuable data. With 
Backup, you can back up all data in RAM. You can save the backup file to an 
optional SD memory card, so you can safeguard your data even while you are 
traveling or away from your PC.

NOTE: For U.S. and European models An internal storage device called “My 
Flash Disk” is included. When using Backup, you can choose this disk as your 
target backup device if the size of your data does not exceed 5 MB.

Backing up data using Backup
1 Close all running applications and insert a memory card.

2 Disconnect your V35 from your PC.

3 On the Start menu on your V35, tap Programs and then tap the Backup 
icon.

4 Tap Backup, then tap Next.

5 Tap your preference of storage media for backing up your data, then tap 
Next.

6 Tap the item you want to back up, then tap Next.

7 Tap Backup, then tap Yes to start the backup process.

8 Remove the memory card after the backup is complete.

CAUTION:

• Never delete the backup file in the memory card. If the backup file is 
deleted, the backup data will be lost and cannot be restored.

• When you use the backup file to restore information, information on 
your V35 is replaced with the information stored in the backup file. 
If you have created files on your V35 since the last backup and do 
not want to delete these files during the restore process, move the 
files from your V35 to your PC--or to an optional memory card--
before restoring the information.
36        ViewSonic   Pocket PC   V35

Download from Www.Somanuals.com. All Manuals Search And Download.



V35_UG.book  Page 37  Monday, October 28, 2002  4:56 PM
Restoring data using Backup
1 Close all running applications and insert a memory card with the backup 

data.

2 Disconnect your V35 from your PC.

3 On the Start menu tap Programs, then tap the Backup icon.

4 Tap Restore, then tap Yes. 

5 Tap your preference of storage media for restoring your data, then tap Next.

6 Tap the item you want to restore, then tap Next.

7 Tap Restore, then tap Yes to start the restore process.

8 Remove the memory card after the restore process is complete, and reset 
your V35.

IMPORTANT: When you restore data, your V35 must have the same regional 
settings that it had when you completed the backup; otherwise, you will not be 
able to restore the files. To change regional settings, on the Start menu, tap 
Settings, and then tap the Regional Settings icon on the System tab. Select 
your region from the drop-down list.
ViewSonic  Pocket PC  V35 37   

Download from Www.Somanuals.com. All Manuals Search And Download.



V35_UG.book  Page 38  Monday, October 28, 2002  4:56 PM
38        ViewSonic   Pocket PC   V35

Download from Www.Somanuals.com. All Manuals Search And Download.



V35_UG.book  Page 39  Monday, October 28, 2002  4:56 PM
 4  Microsoft ActiveSync
This chapter tells you what the Microsoft ActiveSync program is and what you 
need to do to use it.

Using Microsoft ActiveSync
NOTE: ActiveSync is already installed on your V35. You need to install 
ActiveSync on your PC. (For information on installing ActiveSync, see Step 5 of 
the Quick Start procedure in Chapter 1, “Installing Microsoft ActiveSync and 
Connecting to Your PC.” 

Microsoft ActiveSync allows you to synchronize the information on your PC with 
information on your V35. Synchronization compares the data on the two sides 
and updates both computers with the most recent information. For example, 
you can:

• Keep your Pocket Outlook Contacts, Calendar, and Tasks databases up-to 
date by synchronizing your V35 with Microsoft Outlook data on your PC.

IMPORTANT: Outlook must be installed on your PC in order to synchronize 
your email data.

• Synchronize email messages in your V35 Inbox with email messages in 
Microsoft Outlook on your PC.

• Synchronize Microsoft Word and Microsoft Excel files between your V35 and 
PC. Your files will be automatically converted to the correct format.

With ActiveSync, you can also:

• Back up and restore your V35 data.

• Copy (rather than synchronize) files between your V35 and PC.

• Add and remove programs on your V35.
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Synchronizing Data
Once you have created a synchronization partnership and completed the first 
synchronization, you can initiate synchronization from your V35. Follow this 
procedure:

1 Connect your V35 to your PC. (See “Connecting Your PC” in Chapter 1.)

2 On your V35, tap , and then tap ActiveSync.

3 Tap  to begin synchronization.

By default, ActiveSync does not automatically synchronize all types of 
information. Use ActiveSync options to turn synchronization on and off for 
specific information types. You can:

• Control when synchronization occurs by selecting a synchronization mode. 
For example, you can synchronize continually while the V35 is connected or 
only when you choose the synchronize command.

• Select which information types are synchronized and control how much data 
is synchronized. For example, you can choose how many weeks of past 
appointments you want synchronized.

For information on setting ActiveSync options and using ActiveSync on your PC, 
see ActiveSync Help on the PC. For information on using ActiveSync in your 
V35, see ActiveSync Help on the V35.

View connection status.
Tap to connect and synchronize.
Tap to stop sycnchronization.

View synchronization status.

Tap to change Volume or Mute all sounds.
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Connecting to Your PC
CAUTION: Do not shut down or restart your PC while your V35 is 
connected. Turn off your V35 or disconnect the USB cable before you 
shut down your PC. 

Connecting by USB Cable
CAUTION: Before you connect your V35 to the cradle, be sure of the 
following: your PC is on, you have installed ActiveSync on your PC, and 
ActiveSync is configured to allow a USB connection.

You can keep your V35 in the cradle when you are not carrying it with you, 
which keeps it charged and synchronized.

For instructions on connecting, see “Connecting Your PC” in Chapter 1.

Connecting by Infrared
You can use the IR port to synchronize data with your PC, in place of using the 
cable.

IR ports can be found on many notebook computers; however, on a PC, you 
may need to install and configure an IR port. To install the port, follow the 
manufacturer’s instructions.

For complete instructions on connecting to your PC by infrared, refer to 
ActiveSync Help on your PC.
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 5  Pocket Outlook
This chapter introduces you to the basics of Microsoft Pocket Outlook, including 
Calendar, Contacts, Tasks, Notes and Inbox.

Scheduling Appointments/Meetings
Use Calendar to schedule appointments, including meetings and other events.

You can check your appointments in one of several views (Agenda, Day, Week, 
Month, and Year) and easily switch views by using the View menu.

NOTE: You can customize the Calendar display (for example, change the first 
day of the week), by tapping Options on the Tools menu. 

Tap to go to Today.

Tap to display or edit the 
appointment details. 

Tap to create a new appointment.
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Creating an Appointment
1 In Day or Week view, tap the desired date and time for the appointment.

2 Tap New.

3 When using the Input panel, tap first to select the field, and then enter a 
description and a location.

4 If needed, tap the date and time to change them.

5 Enter other desired information. You will need to hide the Input panel to see 
all available fields.

6 To add notes, tap the Notes tab. You can enter text, draw, or create a 
recording. For more information on creating notes, see “Notes: Capturing 
Thoughts and Ideas” later in this chapter.

7 Tap OK to return to Calendar.

NOTE: If you select Remind me in an appointment, your V35 will remind you 
according to the options set in the Sounds & Notifications control panel.

Tap to return to the calendar (the 
appointment is saved automatically).

Tap to choose from predefined text.

Tap to choose from previously 
entered locations.

Tap to select a time.

Tap to select a date.

Notes is a good place for 
maps and directions.
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen displays. To 
change the appointment, tap Edit.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket 
Outlook. The meeting notice will be created automatically and sent either when 
you synchronize Inbox or when you connect to your email server. Indicate how 
you want meeting requests sent by tapping Tools and then Options. If you 
send and receive email messages through ActiveSync, select ActiveSync.

To schedule a meeting:

1 Create an appointment.

2 In the appointment details, hide the Input panel, and then tap Attendees.

3 From the list of email addresses in Contacts, select the meeting attendees.

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar 
Help and Inbox Help on your V35.

View appointment details.

View.

Tap to change appointment.
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Managing Contacts
Contacts maintains a list of your friends and colleagues so that you can easily 
find the information you are looking for, whether you are at home or on the 
road. Using the IR port on the V35, you can quickly share Contacts information 
with users of Pocket PCs and other mobile devices.

NOTE: To change the way information is displayed in the list, tap Tools then 
tap Options.

Select the category of contacts you 
want to display in the list.

Tap and enter part of a name 
to quickly find it in the list.

Tap to see additional phone 
numbers and e-mail addresses.
Tap to display or edit the 
contact details.

Press and hold to display a 
pop-up menu of actions.

Tap to create a new record.
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1 Tap New.

2 Using the Input panel, enter a name and other contact information. You will 
need to scroll down to see all available fields.

3 To assign the contact to a category, scroll to and tap Categories then select 
a category from the list. In the contact list, you can display contacts by 
category.

4 To add notes, tap the Notes tab. You can enter text, draw, or create a 
recording. For more information on creating notes, see “Notes: Capturing 
Thoughts and Ideas” later in this chapter.

5 Tap OK to return to the contact list.

Finding a Contact
There are four ways to find a contact:

• On the Start menu, tap Find, enter the contact name, select Contacts for 
the type, and then tap Go.

• In the contact list, enter a contact name in the box under the Navigation bar.

To show all contacts again, clear text from the box or tap the button to the right 
of the box.

• In the contact list, tap the category list (labeled All Contacts by default) 
then select the type of contact that you want displayed. To show all contacts 
again, select All Contacts. To view a contact not assigned to a category, 
select None.

Tap to return to the contact 
list (the contact is saved 
automatically).

Scroll to see more fields.

Notes is a good place for 
maps and directions.
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• To view the names of companies your contacts work for, in the contact list, 
tap View then tap By Company. The number of contacts that work for that 
company will be displayed to the right of the company name.

Using the Summary Screen
When you tap a contact in the contact list, a summary screen displays. To 
change the contact information, tap Edit.

View contact details.

Tap to view notes.

Tap to change contact information.
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Tasks: Keeping a To Do List
Use Tasks to keep track of what you have to do.

Select the category of tasks you want to 
display in the list.

Select the sort order of the list.

!  Indicates high priority.

Tap to display or edit the task details.

Press and hold to display a 
pop-up menu of actions.

Tap to create a new task.
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Creating a Task
1 Tap New.

2 Using the Input panel, enter a description.

3 You can enter a start date and due date, or enter other information by first 
tapping the field. If the Input panel is open, you will need to hide it to see all 
available fields.

4 To assign the task to a category, tap Categories then select a category from 
the list. In the task list, you can display tasks by category.

5 To add notes, tap the Notes tab. You can enter text, draw, or create a 
recording. For more information on creating notes, see “Notes: Capturing 
Thoughts and Ideas” later in this chapter.

6 Tap OK to return to the task list.

Tap to return to the task list 
(the task is saved automatically).

Tap to choose from 
predefined subjects.

Notes is a good place for 
maps and drawings.
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Using the Summary Screen
When you tap a task in the task list, a summary screen displays. To change the 
task, tap Edit.

View task details.

Tap to show or hide additional 
summary information.

View notes.

Tap to change task.
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Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with 
Notes. You can create a written note or a recording. You can also include a 
recording in a note. If a note is already open when you create the recording, it 
will be included in the note as an icon. If the note list is displayed, the recording 
will be created as a stand-alone recording.

Creating a Note
1 Tap New.

2 Create your note by writing, drawing, typing, or recording. For more 
information about using the Input panel, writing and drawing on the screen, 
and creating recordings, see “Entering Information” in Chapter 2.

Tap to change the sort order of the list.

Tap to change open a note or play a recording.

Press and hold to display a pop-up 
menu of actions.

Tap to record.

Tap to show or hide the Recording toolbar.

Tap to create a new item.
52        ViewSonic   Pocket PC   V35

Download from Www.Somanuals.com. All Manuals Search And Download.



V35_UG.book  Page 53  Monday, October 28, 2002  4:56 PM
Inbox: Sending and Receiving Email
Use the Inbox to send and receive e-mail messages with Microsoft Outlook on 
your PC.

Synchronizing Email Messages
Email messages can be synchronized as part of the general synchronization 
process. To do this, you need to enable Inbox synchronization in ActiveSync. 
For information on enabling Inbox synchronization, see ActiveSync Help on 
the PC.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on your 
PC to the ActiveSync folder in Inbox on your V35.

• Email messages in the Outbox folder on your V35 are transferred to 
Exchange or Outlook, and then sent from those programs.

• Email messages in subfolders must be selected in ActiveSync on your PC in 
order to be transferred.

Using the Message List
Messages you receive are displayed in the message list. By default, the most 
recently received messages are displayed first in the list.

Select the Internet Service Provider and 
the folder you want to display.

Select the sort order for messages.

Tap to open a message.

Press and hold to display a pop-
up menu of actions.

Tap to connect, and to send and receive e-mail.

Tap to connect to the selected Internet 
Service Provider.
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When you receive a message, tap it to open it. Unread messages are displayed 
in bold.

IMPORTANT: When you synchronize with your PC, by default, you will receive 
messages from the last three days only, the first 100 lines of each new 
message, and file attachments of less than 100 KB in size. The original 
messages remain on your PC.

Tap to return to the message list.

Tap to delete this message.

Tap to view the previous or next message.

Tap to reply to or forward this message.
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To compose a message, do the following:

1 Tap New.

2 In the To field, enter an email of one or more recipients, separating them 
with a semicolon, or select a name from the contact list by tapping the 
Address Book button. All email addresses entered in the email fields in 
Contacts appear in the Address Book.

3 Compose your message. To enter preset or frequently used messages, tap 
My Text and select a message.

4 Tap Send when you have finished the message. If you are working offline, 
the message is moved to the Outbox folder and is sent the next time you 
connect. The message is placed in the Outbox folder on your device.

Managing Email Messages and Folders
By default, messages are displayed in one of five folders for each service you 
have created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items. The 
Deleted Items folder contains messages that were deleted from the V35.

The behavior of the Deleted and Sent Items folders depends on the options you 
have chosen. In the message list, tap Tools then tap Options. On the 
Message tab, select your options.

If you want to organize messages into additional sub-folders, tap Tools, then 
tap Manage Folders to create new folders. To move a message to another 
folder, in the message list, press and hold the message then tap Move on the 
pop-up menu.

Tap to show or hide the complete header.

Tap to send the message.

Tap to show or hide the recording toolbar.
Tap to display the Address Book.

Tap to insert common (frequently used) messages.
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 6  Companion Programs
This chapter tells you about Microsoft Pocket Word and Microsoft Pocket Excel.

Pocket Word
Microsoft Pocket Word works with Microsoft Word on your PC to give you easy 
access to copies of your documents. You can create new documents on your 
V35 or you can copy documents from your PC.

IMPORTANT: Synchronize documents between your PC and your V35 regularly 
so that you have the most up-to-date content in both locations. 

Using Pocket Word
1 On the Start, tap Programs and then tap the Pocket Word icon.

2 Type the name of a document in the file list or tap New to open a blank 
document.

NOTE: To open a template rather than a blank document, select a template for 
new documents. Tap on the Tools menu, tap Options, then browse to select 
the default template. When you tap New, the template appears with 
appropriate text and formatting already provided.

You can open only one document at a time; when you open a second document, 
you will be asked to save the first. You can save a document you create or edit 
in a variety of formats, including Pocket Word (.psw), Rich Text Format (.rtf), 
and Plain Text (.txt).

You can enter information in Pocket Word in four modes: writing, drawing, 
typing, and recording. Use the View menu to switch between modes. Each 
mode has its own toolbar which you can show or hide by tapping the Show/
Hide Toolbar button on the Command bar.

• Typing Mode. Use the Input panel to enter typed text into the document 
with the soft keyboard. For more information on entering typed text, see 
“Entering Information” in Chapter 2.

• Writing Mode. In writing mode, use your stylus to write directly on the 
screen. Ruled lines are displayed as a guide, and the zoom magnification is 
greater than in typing mode to allow you to write more easily. For more 
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information on writing and selecting writing, see “Entering Information” in 
Chapter 2.

NOTE: Written words are converted to graphics (metafiles) when a Pocket 
Word document is converted to a Word document on your PC.

• Drawing mode. In drawing mode, use your stylus to draw on the screen. 
Gridlines appear as a guide. When you lift your stylus off the screen after 
the first stroke, you will see a drawing box indicating the boundaries of the 
drawing. Every subsequent stroke within or touching the drawing box 
becomes part of the drawing. For more information on drawing and selecting 
drawings, see “Entering Information” in Chapter 2.

• Recording mode. Use recording mode to embed a recording into your 
document. Recordings are saved as WAV files. For more information on 
recording, see “Entering Information” in Chapter 2.

Tips for Working in Pocket Word
• You can change the zoom magnification by tapping View and then tap 

Zoom. Then select the percentage you want. Select a higher percentage to 
enter text and a lower one to see more of your document. 

• If you are opening a Word document created on a PC, select Wrap to 
Window on the View menu so that you can see the entire document.

Pocket Excel
Microsoft Pocket Excel works with Microsoft Excel on your PC to give you easy 
access to copies of your workbooks. You can create new workbooks in your 
V35, or you can copy workbooks from your PC to your V35. Synchronize 
workbooks between your PC and your V35 so that you have the most up-to-
date content in both locations. Pocket Excel provides fundamental spreadsheet 
tools, such as formulas, functions, sorting, and filtering, which enable you to 
create simple workbooks, such as expense reports and mileage logs.

1 On the Start menu, tap Programs and then tap the Pocket Excel icon.

2 Tap the name of a workbook in the file list or tap New to open a blank 
workbook.

You can open only one workbook at a time; when you open a second workbook, 
you will be asked to save the first. You can save a workbook you have created 
or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).

Tips for Working in Pocket Excel
• View in full-screen mode to see as much of your worksheet as possible. Tap 

View and then tap Full Screen. To exit full-screen mode, tap Restore.

• If your workbook contains sensitive information, you can protect it with a 
password. To do so, open the workbook, tap Edit, and then tap Password.

• Show or hide window elements. Tap View then tap the elements you want 
to show or hide.
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• Freeze panes on a worksheet. First, select the cell where you want to freeze 
panes. Tap View and then tap Freeze Panes. You might want to freeze the 
top and furthest left panes in a worksheet to keep row and column labels 
visible as you scroll through a sheet.

• Split panes to view different areas of a large worksheet. Tap View and then 
tap Split. Then drag the split bar to where you want it. To remove the split, 
tap View and then tap Remove Split.

• Show and hide rows and columns. To hide a row or column, select a cell in 
the row or column you want to hide, tap Format, tap Column, then tap 
Hide. To show a hidden row or column, tap Tools, tap Go To then type a 
reference that is in the hidden row or column. Tap Format, then tap Row or 
Column, then tap Unhide.

Windows Media Player for Pocket PC
Use Microsoft Windows Media Player for V35 to play digital audio and video files 
that are stored on your V35 or on a network. To switch to Windows Media 

Player for V35, tap  and tap Windows Media.

Use Microsoft Windows Media Player on your PC to copy digital audio and video 
files to your V35. You can play Windows Media and MP3 files on your V35.

For more information about using Windows Media Player, tap then tap Help.

Tap to adjust the playback progress 
of a slected file.

Tap to adjust volume.

Tap to play or pause.

Tap to stop.

Tap to skip to the next file.

Tap to play a previous file.

Tap to display a video using the entire screen.

Tap to display the WindowsMedia.com 
website.
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Microsoft Reader
Use Microsoft Reader to read eBooks on your V35. Download books to your PC 
from your favorite eBook Web site. Use ActiveSync to copy the book files to 
your activated V35. The books appear in the Reader Library, where you can tap 
them in the list to open them.

NOTE: Before you can use Microsoft Reader, you must activate it from the 
Microsoft activation site (http://das.microsoft.com/activate). Follow the 
directions given at the Microsoft site.

Each book consists of a cover page, an optional table of contents, and the 
pages of the book. You can:

• Page through the book by using the scroll dial on your V35 or by tapping the 
page number on each page.

• Annotate the book with highlighting, bookmarks, notes, and drawings.

• Search for text or look up definitions for words.

The Guidebook contains all the information you need to use the software. To 
open the Guidebook, tap Help on the Reader command bar. Or, on a book 
page, press and hold on the book title, and then tap Help on the pop-up menu.

To switch to Microsoft Reader, tap , tap Programs then tap Microsoft 
Reader.

Getting Books onto Your V35
You can download book files from the Web. Just visit your favorite eBook 
retailer and follow the instructions to download the book files.

Sample books and a dictionary are also included in the MSReader folder on the 
Companion CD.

Use ActiveSync to download the files from your PC to your activated V35 as 
described in the Read Me file in the MSReader folder.
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Using the Library
The Library is your Reader home page. The home page displays a list of all 
books stored on your V35 or storage card.

To open the Library:

• On the Reader command bar, tap Library.

• On a book page, tap the book title, and tap Library, on the pop-up menu.

To open a book, tap its title in the Library list.

Tap to scroll 
through the 
Library list.Tap to select 

a sort order.

Tap to specify the 
books you want to 
display in the list.

Tap here to navigate 
to other parts of the 
Reader.

Tap to open a 
book.
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Reading a Book
Each book consists of a cover page, an optional table of contents, and the 
pages of the book. Navigation options are listed in the bottom portion of the 
cover page.

The first time you open a book, you will probably want to go to the first page or 
to the table of contents, if there is one. Subsequently, whenever you open the 
book, you automatically go to the last page read.

In addition to the text, each book page includes a page number and book title.

You can also page through a book by using the scroll dial on your V35.

Using Reader Features
Reading a book electronically gives you several options not available with paper 
books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the 
pop-up menu, as described here.

• Search for Text. Find text in a book by tapping Find on the pop-up menu. 
Enter the word you want to search for, and tap the desired Find option. 
Reader highlights found text on the page. To close Find, tap outside the box. 
To return to your original page, tap the title and then tap Return on the 
popup menu.

• Copy Text. You can copy text from books that support this feature into any 
program that accepts text. On a book page, select the text you want to 
copy. Then, tap Copy Text on the pop-up menu. The text can be pasted into 
the program of your choice.

Tap to select a 
navigation option.

Drag to select text 
and then tap an 
option.

Tap arrows to turn 
the page, or press 
and hold page # to 
bring up page title.
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• Bookmarks. When you add a bookmark to a book, a color-coded bookmark 
icon appears in the right margin. You can add multiple bookmarks to a book. 
Then, from anywhere in the book, tap the bookmark icon to go to the 
bookmarked page.

• Highlights. When you highlight text, it appears with a colored background.

• Notes. When you attach a note to text, you enter the text in a note pad that 
appears on top of the book page. A Note icon displays in the left margin. To 
show or hide the note, tap the icon.

• Drawings. When you add a drawing, a Drawing icon appears in the bottom-
left corner of the page and drawing tools appear across the bottom of the 
page. Draw by dragging your stylus.

NOTE: To see a list of a book’s annotations, including bookmarks, highlights, 
text notes, and drawings, tap Annotations Index on the book’s cover page. 
You can tap an entry in the list to go to the annotated page.

Removing a Book
When you finish reading a book, you can delete it to conserve space on your 
V35. If a copy of the book is stored on your PC, you can download it again at 
any time.

To remove a book from your V35, press and hold the title in the Library list, and 
then tap Delete on the pop-up menu.
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Other Programs
The following programs are permanently installed in your V35:

In addition, you can install the following programs from the Pocket PC V35 

Companion CD:

Program How to Access the Program

Infrared 
Receiver

On the Start menu, tap Programs and then tap the Infrared 
Receive icon. Infrared Receive establishes the connection 
between your V35 and the IR device.

Terminal 
Services

On the Start menu, tap Programs and then tap the Terminal 
Services icon. Terminal Services allows you to access the 
programs and documents in a Windows NT server type PC that is 
running Terminal Services.

Backup On the Start menu, tap Programs and then tap the Backup 
icon. Backup enables you to back up all data stored in the 
internal (RAM) memory on your V35. For more information, see 
section “Backing up Data” in Chapter 3.

Program Description

ClearVue™ 
Image Viewer

Allows you to view BMP, JPG, and PNG 
images.

ClearVue™ 
Presentation 
Viewer

Allows you to view presentations created 
with Microsoft PowerPoint 97, PowerPoint 
2000, and PowerPoint 2002 (XP).
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 7  Pocket Internet Explorer
This chapter tells you about Microsoft Pocket Internet Explorer, Mobile Favorites 
Folder and AvantGo Channels.

Using Pocket Internet Explorer
Use Microsoft Pocket Internet Explorer to view Web pages by doing the 
following:

• During synchronization with your PC, download your favorite links and 
mobile favorites that are stored in the Mobile Favorites subfolder in Internet 
Explorer on the PC.

To start Pocket Internet Explorer:

• On the Start menu, tap Internet Explorer. The Pocket Internet Explorer 
home page:

Hide pictures button
Favorites button

Home button

Refresh button
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Viewing Mobile Favorites and Channels
1 Tap the Favorites button to display your list of favorites.

2 In the list, tap the page you want to view.

You will see the page that was downloaded the last time you synchronized with 
your PC. If the page is not on your V35, it will be dimmed in the Favorites list. 
You will need to synchronize with your PC again to download the page to your 
V35, or connect to the Internet to view the page.

Browsing the Internet
To connect and start browsing, do one of the following:

• Tap the Favorites button, and then tap the favorite you want to view.

• Tap View, and then tap Address Bar. In the address bar that appears at 
the top of the screen, enter the Web address you want to visit and then tap 
Go. Tap the arrow to choose from previously entered addresses.

The Mobile Favorites Folder
Only items stored in the Mobile Favorites subfolder in the Favorites folder in 
Internet Explorer on your PC will be synchronized with your Pocket PC. This 
folder is created automatically when you install ActiveSync.

Tap the Favorite you want to view.

Tap to add or delete a 
folder or Favorite link.
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Favorite Links
During synchronization, the list of favorite links in the Mobile Favorites folder on 
your PC is synchronized with Pocket Internet Explorer on your V35. Both 
computers are updated with changes made to either list each time you 
synchronize. Unless you mark the favorite link as a mobile favorite, only the 
link (and not the page) will be downloaded to your V35, and you must connect 
to your ISP or network to view the content. For more information on 
synchronization, see ActiveSync Help on your PC.

Mobile Favorites
If you are using Microsoft Internet Explorer 5 or later on your PC, you can 
download mobile favorites to your V35. When you synchronize your PC and 
V35, the content of your mobile favorites is downloaded to your V35 so that you 
can view pages while you are not connected to your ISP or your network.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile 
favorites quickly.

To create a mobile favorite:

1 In Internet Explorer on your PC, click Tools, and then click Create.

• To change the link name, enter a new name in the Name box.

• To change how often the mobile favorite is updated, select a desired 
update schedule under Update.

2 Click OK. Internet Explorer downloads the latest version of the page to 
your PC.

3 If you want to download the pages that are linked to the mobile favorite you 
just created, right-click the mobile favorite and then click Properties. On 
the Download tab, specify the number of links deep you want to download. 
To conserve memory on your V35, download only one level of links.

4 Synchronize your V35 and PC. Mobile favorites that are stored in the Mobile 
Favorites folder in Internet Explorer are downloaded to your V35.

NOTE: If you do not specify an updated schedule, you must manually download 
content to keep the information updated on your PC and V35. Before 
synchronizing in Internet Explorer or your PC, click Synchronize on the Tools 
menu. You will see the last time content was downloaded to your PC, and you 
can manually download if needed.

NOTE: You can add a button to the Internet Explorer toolbar for creating 
mobile favorites. In Internet Explorer on your PC, on the View menu, click 
Toolbars, and then click Customize.

Conserving Memory
Mobile favorites take up storage memory on your V35. Follow these tips to 
minimize the amount of memory used:
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• Use ActiveSync settings to turn off pictures and sounds for the Mobile 
Favorites information type or to stop some mobile favorites from being 
downloaded to your V35. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Internet Explorer on the 
PC, right-click the mobile favorite you want to change, and then click 
Properties. On the Download tab, specify 0 or 1 for the number of linked 
pages you want to download.

Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized 
content and thousands of popular Web sites. You subscribe to AvantGo channels 
directly from your V35. Then you synchronize your V35 with your PC or connect 
to the Internet to download the content. For more information, visit the 
AvantGo Web site.

To sign up for AvantGo:

1 In ActiveSync options on the PC, turn on synchronization for the AvantGo 
information type.

2 In Pocket Internet Explorer on your V35, tap the Favorites button to display 
your list of favorites.

3 Tap the AvantGo Channels link.

4 Tap the Activate button.

5 Follow the directions on the screen. You will need to synchronize your V35 
with your PC, and then tap the My Channels button to complete the 
AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list 
of favorites to see a few of the most popular channels. To add or remove 
channels, tap the Add or Remove link.
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 8  Getting Connected
Using infrared (IR), you use your V35 to exchange information (such as 
contacts and appointments) with other mobile devices as well as your PC. (For 
more information, see “Using Microsoft ActiveSync” in Chapter 4.) You have the 
following connection options: 

• Use the infrared (IR) port on the V35 to exchange (send/receive) files with 
another mobile device. If this is the method you want to use, see the 
“Transferring Information Using Infrared” section on this page.

• Connect to your PC to synchronize remotely. Once your V35 is connected to 
your PC, you can synchronize information such as your Pocket Outlook 
Information. If this is the method you want to use, see ActiveSync Help on 
your PC or Connections Help on the V35.

Transferring Information Using Infrared
Sending Information
1 Switch to the program in which you created the item you want to send then 

locate the item in the list.

2 Align the IR ports so that they are unobstructed and within a close range.

CAUTION: If the devices are too far apart or if something blocks the 
path between the two ports, data might not be sent or received 
correctly.

3 Press and hold the item, then tap Beam Item on the pop-up menu.

NOTE: You can also send items, but not folders, from File Explorer. Press and 
hold the item you want to send, then tap Beam File on the pop-up menu.

Receiving Information
1 Align the IR ports so that they are unobstructed and within a close range.

2 Tap , tap Programs, then tap Infrared Receive.

3 Have the owner of the other device send the information to you. Your V35 
automatically receives it.
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 9  Troubleshooting and 
Maintenance

This chapter gives solutions to common V35 problems you may encounter when 
using the device. It also provides guidelines on taking care of your V35.

NOTE: If you encounter a problem you cannot solve, contact your reseller or 
ViewSonic Customer Support. See the “Customer Support” section at the end of 
this chapter.

Resetting your V35
CAUTION: Resetting will cause unsaved data to be lost.

Resetting your V35 is similar to restarting your PC. It restarts the operating 
system, but you will lose any unsaved data. Occasionally, you may need to 
reset your V35. For example, you should reset your V35:

• After you restore data from your PC.

• When your V35 stops responding. (In other words, it appears to be “frozen” 
or “locked up.”)

Follow this procedure to reset your V35:

1 Remove the memory card (if installed).
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2 Unscrew the tip of your stylus. Use the tip to press the reset button on the 
side of your V35.

Restoring Factory Defaults
In some cases, you may need to restore your V35 to the factory default settings 
by clearing the memory (RAM) from your V35. For example, you should clear 
the memory:

• When your V35 does not respond after being reset.

• When you forget your password.

Clearing the memory means all data you have entered in RAM, including all 
files, system settings, and additional programs you have installed, will be 
erased. (Programs installed to ROM at the factory are not affected.)

CAUTION:

• To ensure the integrity of your data should it be necessary to clear 
the memory, you are advised to regularly back up to your PC (using 
ActiveSync), or to an optional SD card (using the backup 
application). For more information on backing up data, see “Backing 
Up Data” in Chapter 3.

• Do not push the battery switch unless it is necessary. 
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Follow this procedure to clear the memory from your V35:

1 Disconnect all cables, including the AC adapter, from your V35.

2 Unscrew the tip of the stylus. Use the tip to push the battery switch to the 
OFF (up) position.

3 Wait for three (3) minutes then push the battery switch to the ON (down) 
position.

4 The Notification indicator will flash red for approximately 30 seconds, and 
then your V35 will automatically turn on and display the Welcome Wizard 
screen.

NOTE: If the battery runs completely out of power and is not re-charged in 
time, the memory of your V35 will be cleared.

Power Problems
Power does not turn on when using battery power
• The remaining battery power may be too low to run your V35. Connect the 

AC adapter to your V35 and to external AC power. Then, turn on your V35. 
(Charge the battery whenever possible to avoid running out of battery 
power.)

Battery runs out of power quickly
• You might be using your V35 in ways that drain power quickly. (See 

“Managing Power” in Chapter 3 for tips on saving power.)
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Memory Problems
If a warning message of not enough memory appears due to the memory 
allocation problem, try the following to free memory on your V35.

CAUTION: Be discreet when you delete files. Deleting files of which the 
function is unknown can cause programs or features to malfunction. It 
is recommended that you to create a backup before deleting files.

• Delete files you no longer need. Tap , Programs, and then File Explorer. 
Press and hold the file you wish to delete, then tap Delete on the pop-up 
menu. To find your largest files, tap then Find. In the Type list, tap 
Larger than 64KB, then tap Go.

• Remove programs you no longer need. Tap and then Settings. Tap 
System tab, then tap Remove Programs. Tap the program you want to 
remove then tap Remove.

• In Internet Explorer options, delete all files then clear history. In Internet 
Explorer, tap Tools then Options. Tap Delete Files then Clear History.

• If you are copying files from a computer or other device to your V35, try 
adjusting the slider in the Memory setting. Tap then Settings. Tap 
System tab, then tap Memory. Check to see if you can manually move the 
slider before copying files.

Stop programs you are not currently using. In most cases, programs 
automatically stop to free needed memory. However, in some situations, such 
as when confirmation dialog boxes are waiting for a user response, the program 
may not be able to automatically stop. To check the state of your active 
programs, tap then Settings. Tap System tab, tap Memory, then Running 
Programs. Tap the program you want to view then tap Activate. Close any 
open windows or messages and return the program to list view. If this does not 
work, you can stop the program manually. First, make sure that your work is 
saved by closing open items and return the program to list view. Then, stop the 
program by tapping Stop or Stop All on the Running Programs tab.

Reset your V35 as described earlier in this chapter.

If you have an SD card, move data to the SD card as follows:
• Tap , Programs, then File Explorer. Press and hold the file you want to 

move, then tap Cut. Browse to My Documents folder in the SD card folder, 
tap Edit, then Paste. Files stored in folders other than My Documents or 
stored in subfolders within subfolders in My Documents may not show up in 
the list view of some programs. When using Notes, Pocket Word, or Pocket 
Excel, you can also move files by opening the item then tapping Tools or 
Edit then Rename/Move.

• Move email attachments. In Inbox, tap Tools then Options. Tap Storage 
tab and select Store attachments on memory card. All attachments are 
moved to the SD card, and new attachments are automatically stored on the 
SD card.
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• Set programs such as Notes, Pocket Word, and Pocket Excel to automatically 
save new items on the SD memory card. In the program, tap Tools then 
Options.

Screen Problems
Screen is off
If the screen does not respond, even after you press the power button, try the 
following until the problem is solved:

• Connect the AC adapter to your V35 and to external AC power, then

• Reset your V35 as described in “Resetting Your V35” earlier in this chapter.

Screen responds slowly
• Make sure that your V35 is not running out of battery power or running 

many active programs. If the problem still exists, reset your V35 as 
described in “Resetting Your V35” earlier in this chapter.

Screen freezes
• Reset your V35 as described in “Resetting Your V35” earlier in this chapter.

Screen is hard to read
• Make sure that the backlight of the display is on.

• Move to a location with enough light.

• If you are having a hard time reading a document on the screen, try 
adjusting the zoom percentage or text size.

- In Notes, tap Tools and select a zoom percentage.

- In Pocket Word and Pocket Excel, tap View, tap Zoom then select a zoom 
Percentage.

- In Pocket Internet Explorer, tap View, tap Text Size then select a size.

- In Calendar, Contacts, and Tasks, tap Tools, tap Options then select User 
large font.

Inaccurate response to stylus taps
Realign the touch screen. Tap and tap Settings. Tap System tab then tap 
Align Screen. If you cannot realign the touch screen, turn off the V35. Press 
and hold the scroll dial, then press the power button to turn on the V35. You 
should now be able to start the touch screen alignment process.
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Connection Problems
USB Cradle Connection Problems
• Make sure that you have installed the correct version of ActiveSync on your 

desktop PC. Install the version ActiveSync included with your V35.

• Make sure that your V35 and your desktop PC are turned on.

• Make sure that you do not have any other active connections.

• When using the USB cradle, make sure that your V35 is properly seated.

• Make sure that the cable is securely plugged into the USB port on your 
desktop PC. Connect the USB cable directly to your desktop PC — do not run 
the cable through a USB hub.

• Make sure that the USB connection is enabled in ActiveSync on your desktop 
PC. If the USB connection is already enabled, disable the USB connection, 
close the Connection Settings window, and then reopen and re-enable the 
USB connection.

• Reset your V35 before connecting the USB cable. (See “Resetting Your V35” 
earlier in this chapter.) Always disconnect your V35 before you restart your 
desktop PC.

• Connect only one V35 or personal digital assistant to your desktop PC at 
a time.

Infrared Connection Problems
• Transfer only one file, or no more than 25 contact cards, at a time.

• Position the IR ports so that they line up at a distance less than 20 cm (8 
inches) but more than 5 cm (2 inches) apart.

• Make sure that there are no obstacles between the two IR ports.

• Adjust the room lighting. Some types of light interfere with IR 
communications. Try moving to a different location or turning off some 
lights.

Care and Maintenance
Taking good care of your V35 will ensure trouble-free operation and reduce the 
risk of damage to your V35.

General Guidelines
• Keep your V35 away from excessive moisture and extreme temperatures.

• Avoid exposing your V35 to direct sunlight or strong ultraviolet light for 
extended periods of time.

• Do not place anything on top of your V35 as this may damage the display.

• Do not drop your V35.
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• Store your V35 in a protective case when not in use.

• The screen surface is easily scratched. Use only the stylus to tap on the 
screen. Avoid touching it with your fingers, pens, or pencils.

• Never clean your V35 with the power on. Use a soft, lint-free cloth 
moistened with water to wipe the screen and the exterior of your V35.

• Never use paper towels to clean the screen.

Travel Guidelines
• Before traveling with your V35, back up your data. As an added precaution, 

bring along a backup copy.

• Turn off your V35 and disconnect all external devices.

• Make sure that the battery is fully charged.

• Take the AC adapter with you. Use the AC adapter as the power source and 
as a battery-recharger.

• Hand-carry your V35 in a protective case.

• Consult the airlines first before using your V35 on the plane. You need to be 
very careful when using electronic devices during the flight.

• If you plan to travel abroad with your V35, consult your dealer for the 
appropriate AC adapter for use in your country of destination.
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Customer Support
For technical support or product service, see the table below or contact your 
reseller.

IMPORTANT:
• You will need to provide the product serial number (on the back of 

the V35).

• Before sending the V35 out for service, be sure to backup all data 
and remove all third party software. See the Data Loss Disclaimer in 
the Appendix

Country/
Region

Website / Email
T = Telephone
F = FAX

United States

Canada

www.VSMobile.com/support
VSMobile@viewsonic.com

www.viewsonic.com/support
service.ca@viewsonic.com

T: (800) 688-6688
F: (909) 468-1202

T: (800) 688-6688
F: (909) 468-1202

United Kingdom www.VSMobile.com/support
service.eu@viewsoniceurope.com

T: 0800 833 648
F: 01794 500801

Europe, Middle 
East, Baltic 
countries, and 
North Africa

www.viewsoniceurope.com
service.eu@viewsoniceurope.com

Contact your reseller

Australia and New 
Zealand

www.viewsonic.com.au
service.au@viewsonic.com

T: +61 2 9929 3955
F: +61 2 9929 8393

Singapore/India 
and Southeast 
Asia

www.viewsonic.com.sg
service.sg@viewsonic.com

T: 65 273 4018
F: 65 273 1566

Other Asia/Pacific 
countries 

www.viewsonic.com.tw
service.ap@viewsonic.com

T: 886 2 2246 3456
F: 886 2 8242 3668

South Africa www.viewsonic.com/asia
service.ap@viewsonic.com

T: 886 2 2246 3456
F: 886 2 8242 3668
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 10  Appendix

Regulatory and Safety Information
Class B Regulations

USA
This equipment complies with the limits for a class B digital device as specified 
in Part 15 of FCC Rules which provide reasonable protection against harmful 
interference in a residential area. This equipment generates and uses radio 
frequency energy, and if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. In the unlikely event that there is interference to radio or television 
reception (which can be determined by turning the equipment off and on), the 
user is encouraged to try to correct the interference by one or more of the 
following measures:

• Reorienting or relocating the receiving antenna (radio or television).

• Relocating the equipment with respect to the receiver.

• Consult your dealer or an experienced radio/television technician.

• Any changes or modifications to the equipment not expressly approved by 
the manufacturer could void the user's authority to operate this equipment.

• Use of a shielded interface cable is required to comply with the Class B limits 
of Part 15 of FCC rules.

Canada
This Class B digital apparatus meets all requirements of the Canada 
Interference-Causing equipment regulations.

Cet appareil numérique de Classe B respecte toutes les exigences du 
Règlement Canadien sur le matériel brouileur.
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European Regulatory Notice
Products with the CE mark comply with both the Electromagnetic Compatibility 
Directive (89/336/EEC) and the Low Voltage Directive (73/23/EEC) - as 
mandated by Directive 93/68/ECC - issued by the Commission of the European 
Community.

Compliance with these directives implies conformity to the following European 
standards:

EN55022: Radio disturbance characteristics
EN55024: Immunity characteristics
EN6100-3-2: Limits for harmonic current emissions
EN6100-3-3: Limitation of voltage fluctuation and flicker in low-voltage 
supply system
EN60950: Product Safety

Battery Replacement
A Lithium Ion battery in this Pocket PC maintains system configuration 
information. In the event that the battery fails to maintain system 
configuration, we recommend that you call your local dealer.

The battery must be replaced by authorized service personnel. Contact your 
dealer or ViewSonic for service contact information. Do not attempt to 
replace the battery yourself. 

WARNING: This unit contains a Lithium Ion battery that is not user-
replaceable. To reduce risk of fire or burns, do not disassemble, 
crush, puncture, or dispose of the battery in fire or water. 
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About the AC Adapter
CAUTION: Only use the AC adapter (PHIHONG, PSC0R-050) supplied 
with your Pocket PC V35. Use of another type of AC adapter will result 
in malfunction and/or danger.

NOTE: This product is intended to be supplied with a Listed Power Unit marked 
“LPS” and output rated +5 V DC / 900 mA minimum.

The AC adapter is designed to ensure your personal safety and to be compatible 
with this equipment. Please follow these guidelines:

• Do not use the adapter in a high moisture environment. Never touch the 
adapter when your hands or feet are wet.

• Allow adequate ventilation around the adapter. Avoid locations with 
restricted airflow.

• Connect the adapter to a proper power source. The voltage and grounding 
requirements are found on the product case and/or packaging.

• Do not use the adapter if the cord becomes damaged.

• Do not attempt to service the unit. There are no serviceable parts inside. 
Replace the unit if it is damaged or exposed to excess moisture.

About Electrostatic Discharge

Electrostatic Discharge Warning
Electrostatic discharges can interfere with the normal functioning of electronic 
devices. Your Pocket PC can behave abnormally owing to such an event, 
resulting in the possible data corruption or loss of unsaved data. To recover 
from this, reset your Pocket PC as described in this User Guide.

NOTE: To avoid losing data due to electrostatic discharges or other types of 
events, it is recommended that you regularly save and backup data as 
described in this User Guide.
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Limited Warranty
Pocket PC Products

What the warranty covers:
ViewSonic® warrants its Pocket PC products to be free from defects in material and workmanship during 
the warranty period. If a Pocket PC product proves to be defective in material or workmanship during the 
warranty period, ViewSonic will, at its sole option, repair or replace the product with a like product. 
Replacement product or parts may include remanufactured or refurbished parts or components. 
ViewSonic provides no warranty for the third party software included with the product. For specific 
warranty information, please see the EULAs included with the product. ViewSonic does not warrant that 
software will meet your requirements or that operation of software will be uninterrupted or error free. 
VIEWSONIC AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES AND CONDITIONS, EITHER EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT.

How long the warranty is effective:*
ViewSonic Pocket PCs are warranted for one (1) year for all parts (except software) and one (1) year for 
all labor from the date of the first consumer purchase.
Who the warranty protects:
This warranty is valid only for the first consumer purchaser.

What the warranty does not cover:
1. Software
2. Any product on which the serial number has been defaced, modified or removed.
3. Damage, deterioration or malfunction resulting from:

a. Accident, misuse, neglect, fire, water, lightning, or other acts of nature, unauthorized product 
modification, or failure to follow instructions supplied with the product.

b. Repair or attempted repair by anyone not authorized by ViewSonic.
c. Damage to or loss of any programs, data or removable storage media.
d. Software or data loss occurring during repair or replacement.
e. Any damage of the product due to shipment.
f. Removal or installation of the product.
g. Causes external to the product, such as electrical power fluctuations or failure.
h. Use of supplies or parts not meeting ViewSonic's specifications.
i. Normal wear and tear.
j. Any other cause which does not relate to a product defect.

4. Removal, installation, and set-up service charges.
How to get service:
1. For information about receiving service under warranty, contact ViewSonic Customer Support. You 

will need to provide your product's serial number.
2. To obtain service under warranty, you will be required to provide (a) the original dated sales slip, (b) 

your name, (c) your address, (d) a description of the problem, and (e) the serial number of the 
product.

3. Take or ship the product freight prepaid in the original container to an authorized ViewSonic service 
center or ViewSonic.

4. For additional information or the name of the nearest ViewSonic service center, contact ViewSonic.
Limitation of implied warranties: 
THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, WHICH EXTEND BEYOND THE DESCRIPTION 
CONTAINED HEREIN INCLUDING THE IMPLIED WARRANTY OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.

Exclusion of damages:
VIEWSONIC'S LIABILITY IS LIMITED TO THE COST OF REPAIR OR REPLACEMENT OF THE PRODUCT. 
VIEWSONIC SHALL NOT BE LIABLE FOR:
1. DAMAGE TO OTHER PROPERTY CAUSED BY ANY DEFECTS IN THE PRODUCT, DAMAGES BASED 

UPON INCONVENIENCE, LOSS OF USE OF THE PRODUCT, LOSS OF DATA, LOSS OF TIME, LOSS 
OF PROFITS, LOSS OF BUSINESS OPPORTUNITY, LOSS OF GOODWILL, INTERFERENCE WITH 
BUSINESS RELATIONSHIPS, OR OTHER COMMERCIAL LOSS, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

2. ANY OTHER DAMAGES, WHETHER INCIDENTAL, CONSEQUENTIAL OR OTHERWISE.
3. ANY CLAIM AGAINST THE CUSTOMER BY ANY OTHER PARTY.

Effect of state law:
This warranty gives you specific legal rights, and you may also have other rights which vary from state to 
state. Some states do not allow limitations on implied warranties and/or do not allow the exclusion of 
incidental or consequential damages, so the above limitations and exclusions may not apply to you.
Sales outside the U.S.A. and Canada: 
For warranty information and service on ViewSonic products sold outside of the U.S.A. and Canada, 
contact ViewSonic or your local ViewSonic dealer.
* For Europe: This Limited Warranty is effective in Europe for two (2) years for all parts (except 

software) and two (2) years for all labor from the date of the first consumer purchase.

ViewSonic Pocket PC Warranty (V1.0) Release Date: September 9, 2002
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Specifications
Processor Processor

Speed 
Cache

Intel X-Scale PXA250
300 MHz
32 KB Data, 32 KB Instruction

Memory RAM
ROM

64 MB SDRAM, 100 MHZ, 32-BIT
32 MB M-System Disk-On-Chip

Storage SD Secure Digital (SD)

Operating System Microsoft Pocket PC 2002 Premium Edition

LCD Screen Type
Luminance
Backlight
Resolution
Screen Size
Colors

Transflective TFT
Up to 60 Cd/m2 (Nits)
6 LEDs
320 x 240
3.5 inches
Up to 64K colors

Video Chip Integrated with X-Scale PXA250

Audio Features Voice Recording (Mono)
MP3 Playback support

Input/Output Touch Panel
Input Method

Microphone
Speaker
Headphones
USB
Infrared
Serial
Cradle
AC/DC

Resistive Touch Panel
Stylus pen, On-Screen keyboard, and 
Handwriting recognition software
Built-in (mono)
Built-in
3.5 mm mini jack
USB 1.1 (Client) for ActiveSync
IrDA (SIR, 115.2 kbps)
UART 16650 for ActiveSync
22 pin cradle connector
5 V, 1 A, DC jack

Indicators Color LED Amber -- charging
Red (blinking) -- notification

Power Battery

AC Adapter

Lithium Ion, 900 mAh
Active Mode: up to 8 hours (Backlight Off)
Suspend Mode: 14 days
Replace battery at service center.
NOTE: memory state is maintained a minimum 
of 72 hours after low battery shut-down.

Input: 100~240 VAC 50~60 Hz
Output: 5 V DC, 1 A
Recharge: 2.5 hours (100%)
NOTE: AC adapter can be connected to main 
unit or cradle.

Dimensions Physical
(Pocket PC V35) 

122.5 mm (H) x 76.8 mm (W) x 12.6 mm (D)
4.8” (H) x 3.0” (W) x 0.5” (D)

Weight Net 118 g (4.2 oz.)

Operating Conditions Temperature
Humidity

32° F to 104° F (0° C to +40° C)
20% to 90% RH

Storage Conditions Temperature
Humidity

14° F to +140° F (-10° C to +60° C)
20% to 90% RH

Regulations UL/cUL, FCC Part 15 B, CE, TUV/GS, BSMI, 
VCCI, C-tick, CCC 
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SDRAM Memory Allocation
The V35 has 64 MB of SDRAM memory:

• 27.5 MB is used by the Pocket PC 2002 Operating System, applications, and 
drivers. 

• The remaining memory is available for user applications and file storage: 
36.5MB for the USA and Europe V35 models and 29.5MB for the Asian V35 
models.

Memory Map for 64MB SDRAM:

NOTE: The USA and Europe V35 models have an additional 5.2 MB of Flash 
ROM memory available for file storage called "My Flash Disk."

• This Flash ROM memory is available because the USA and European models 
languages require less space.

• The Asian models do not have "My Flash Disk" memory available.

Data Loss Disclaimer
Before sending the V35 out for service, be sure to backup all data and remove 
all third party software.

With respect to all service provided, it is your responsibility to backup the 
contents of your V35, including any data you have stored or software you have 
installed on the V35. It is likely that the contents of your V35 will be lost in the 
course of service and ViewSonic will not be responsible for any damage to or 
loss of any programs, data or other information stored on any media or any 
part of any Product serviced hereunder. 

IF DURING THE REPAIR OF THE PRODUCT THE CONTENTS OF THE V35 ARE 
ALTERED, DELETED, OR IN ANY WAY MODIFIED, VIEWSONIC IS NOT 
RESPONSIBLE WHATSOEVER. YOUR PRODUCT WILL BE RETURNED TO YOU 
CONFIGURED AS ORIGINALLY PURCHASED (SUBJECT TO AVAILABILITY OF 
SOFTWARE).

Be sure to remove all third party hardware, software, features, parts, options, 
alterations, and attachments not warranted by ViewSonic prior to sending the 
product to ViewSonic for service. ViewSonic is not liable for any loss or damage 
to these items.

 Description
USA and European 
Models

Asian Models

Flash ROM Image allocated for 
Pocket PC 2002 Operating System 
and applications

24.0 MB 31.0 MB

Drivers 3.5 MB 3.5 MB

Available for user applications and 
file storage

36.5 MB 29.5 MB

Total Memory 64.0 MB 64.0 MB
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